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Safety Notices
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General Safety
Considerations

NOTE

Installing the 86100C
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Installing the 86100C

This chapter shows you how to properly set up your 86100C. Follow the steps
in the order presented. In addition, you will learn about care and use of elec-
trical and optical connections.

Figure 1-1. 86100C Front Panel

This product has been designed and tested in accordance with the standards
listed in the Manufacturer’s Declaration of Conformity, and has been supplied
in a safe condition. The documentation contains information and warnings
which must be followed by the user to ensure safe operation and to maintain
the product in a safe condition.

Install the instrument according to the enclosure protection provided. This
instrument does not protect against the ingress of water. This instrument pro-
tects against finger access to hazardous parts within the enclosure.
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WARNING

WARNING

WARNING

CAUTION

CAUTION

Instrument Markings
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If this product is not used as specified, the protection provided by the
equipment could be impaired. This product must be used in a normal
condition (in which all means for protection are intact) only.

No operator serviceable parts inside. Refer servicing to qualified
service personnel. To prevent electrical shock do not remove covers.

This is a Safety Class 1 Product (provided with a protective earthing
ground incorporated in the power cord). The mains plug shall only be
inserted in a socket outlet provided with a protective earth contact.
Any interruption of the protective conductor inside or outside of the
product is likely to make the product dangerous. Intentional
interruption is prohibited.

VENTILATION REQUIREMENTS: When installing the product in a cabinet, the
convection into and out of the product must not be restricted. The ambient
temperature (outside the cabinet) must be less than the maximum operating
temperature of the product by 4° C for every 100 watts dissipated in the
cabinet. If the total power dissipated in the cabinet is greater than 800 watts,
then forced convection must be used.

This product is designed for use in INSTALLATION CATEGORY Il and
POLLUTION DEGREE 2 per IEC 1010 and 664 respectively.

Installation Category: Installation Categories (overvoltage categories) are
determined by the transient overvoltage levels that may be expected. CAT I:
Mains isolated. CAT II: Line voltage in appliance and to wall outlet. CAT IlI:
Line voltage behind wall outlet to next level of distribution.

The instruction manual symbol. The product is marked with this warn-
A ing symbol when it is necessary for the user to refer to the instructions
in the manual.

The laser radiation symbol. This warning symbol is marked on products
which have a laser output.

ON, [OFF, 0 ¢h ~y The ON, ON, STANDBY, OFF, OFF and AC symbols.
The ON, OFF, and STANDBY mark the position of the
instrument power line switch. The AC symbol is used

to indicate the required nature of the line module input power.

ce The CE mark is a registered trademark of the European Community.

The CSA mark is a registered trademark of the Canadian Standards

3 Association.
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The C-Tick mark is a registered trademark of the Australian Spectrum
Management Agency.

s This text denotes the instrument is an Industrial Scientific and Medical
Group 1 Class A product.

ces/nveoo1 T IS is @ marking to indicate product compliance with the Cana-
dian Interference-Causing Equipment Standard.
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Installing the 86100C
Step 1. Inspect the shipment

Package Contents

Optional Accessories

Optional Adapters for
Electrical Channel
Inputs

Step 1. Inspect the shipment

Inspect the shipping container and instrument for damage.

Keep the shipping container and cushioning material until you have inspected
the contents of the shipment for completeness and have checked the instru-
ment mechanically and electrically.

Locate the shipping list. Verify that you received all the accessories on this list,
and all the options that you ordered. The following list shows some of the items
that may be on the shipping list. The information on your actual shipping list is
more accurate and should supersede the information in this list.

< Infiniium DCA

« Keyboard, USB (p/n 0960-2427)

* Mouse, USB (p/n 1150-7799)

* Flash drive, USB (p/n 1818-8989)

e External CD-RW drive, USB (p/n 0950-4658)

« Two power cords

e APC 3.5 (f-f) adapter/connector saver (p/n 5061-5311)
e Quick Start Guide (this book)

* Programmer’s Guide

« Filler panel 86101-60005

« 11667B Power splitter, dc to 26.5 GHz, APC 3.5 mm
* 11667C Power splitter, dc to 50 GHz, 2.4 mm

« 11898A Plug-in module remote/extender

* 11982A High-speed lightwave receiver

* 54006A 6 GHz Resistive divider probe kit

* 54008B 24 ns delay line

e 54701A 2.5 GHz active probe

« 83440B/C/D Optical-to-Electrical Converters (6/20/34 GHz)
e 83480A-K16 Switch matrix

e 83480A-K17 RIMM fixture

* N1020A 6 GHz TDR probe kit (passive)

* N1022A Active Probe Adapter

SMA (f-f) adapter, Agilent part number 1250-1158
APC 3.5 (f-f) adapter, Agilent part number 5061-5311
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Step 1. Inspect the shipment

Optional Adapters for

Optical Channel Table 1-1. Fiber-Optic Adapters for Optical Channels
Inputs
Front Panel
Fiber-Optic Adapters Description Agilent Part Number
UIIE Diamond HMS-10 81000Al
= FC/PC 81000F!
[ME D4 810006!
= sc 81000KI
@ DIN 810003
@ ST 81000V
— Biconic 81000W!

86100C-001, Enhanced 12.5 GHz Trigger Bandwidth, providing pattern lock
and eyeline capabilities.

e 86100C-090, Removable hard disk

e 86100C-200, Enhanced Jitter Analysis Software

e 86100C-201, Advanced Waveform Analysis Software

e 86100C-AFP, Additional filler panel

e 86100C-AX4, Rack mount flange kit

e 86100C-AXE, Rack mount flange kit with handles

* 86100C-UK6, Commercial calibration certificate with test data

Instrument Options

”

If anything is missing or defective, refer to “Contacting Agilent Technologies
on page 1-40. If the shipment was damaged, contact the carrier, then contact
the nearest Agilent Sales Office. Keep the shipping materials for the carrier’s
inspection. The Agilent Sales Office will arrange for repair or replacement at
Agilent’s option without waiting for claim settlement.
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Step 2. Position the Infiniium DCA

NOTE

CAUTION

Step 2. Position the Infiniium DCA

e Position the Infiniium DCA so that it is not difficult to unplug the power cord.

« Position the Infinilum DCA where it will have sufficient clearance for airflow

around the top, back, and sides.

Review the following specifications to ensure that your operating or storage en-
vironment is suitable for the instrument.

Install the instrument so that the detachable power cord is readily identifiable
and is easily reached by the operator. The detachable power cord is the
instrument disconnecting device. It disconnects the mains circuits from the
mains supply before other parts of the instrument. The front panel switch is
only a standby switch and is not a LINE switch. Alternatively, an externally
installed switch or circuit breaker (which is readily identifiable and is easily
reached by the operator) may be used as a disconnecting device.

If the Infiniium DCA is mounted in a rack or cabinet, do not use the system’s
power switch to disconnect power from the Infiniium DCA. Instead, use the
Infiniium DCA's front-panel power switch. Using the system power switch may
corrupt the Windows XP registry requiring you to perform a recovery process
to restore normal operation to the Infiniium DCA.

Table 1-2. Environmental Specifications (1 of 2)

Use indoor
Temperature
Operating 10 °C to +40 °C (50 °F to + 104 °F)
Non-operating —40 °C to +65 °C (—40 °F to +158 °F)
Humidity
Operating Up to 90% humidity (non-condensing) at +40 °C (+104 °F)
Non-operating Up to 95% relative humidity at + 65 °C (+149 °F)
Altitude
Operating Up to 3,050 meters (10,000 ft)
Non-operating Up to 12,200 meters (40,000 ft)
Vibration
Operating Random vibration 5-500 Hz, 10 minutes per axis, 0.21 g(rms)
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Step 2. Position the Infiniium DCA

Table 1-2. Environmental Specifications (2 of 2)

Non-operating Random vibration 5-500 Hz, 10 minutes per axis, 2.1 g(rms);
Resonant search, 5-500Hz swept sine, 1 octave/minute
sweep rate, 0.5 g, 10 minute resonant dwell at 4 resonances

per axis.
Power requirements
Voltage 90 to 132 or 198 to 264 Vac, 48-66 Hz CAT II
Power (including modules) 604 VA; 391 W
Weight
Mainframe 15.5kg (34 Ib)
Modules 1.2kg (2.6 1b)
Dimensions
Height 221.5mm (8.72 in)
241.8 (9.52 in) with bottom feet
Width 425.6 mm (16.75 in)
447.7 (17.63 in) with handles
Depth 562.7 (22.2 in)

619.5 mm (24.4 in) front panel Trigger connector to rear foot
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Step 3. Install the modules

Step 3. Install the modules

Up to two modules can be inserted into the Infinilum DCA. All documentation
(including specifications) for plug-in modules is located in the 86100C’s Help
system. To access the Help system, complete the installation steps, turn on
the 86100C, and click Contents on the Help menu.

1 Slide the module into an available front-panel slot.
You can remove or install a module while the instrument is operating.

2 Finger tighten the two knurled locking screws on the module’s front panel.

™ e

Locking screws

Figure 1-2. Installing a Module
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Installing the 86100C
Step 4. Connect the keyboard and mouse

Step 4. Connect the keyboard and mouse

NOTE To complete the installation, you must connect the keyboard to the 86100C.
Since the 86100C has a touch screen, the use of a mouse is optional.

1 Connect the supplied USB keyboard to either of two USB ports located on the
rear panel. Most users find it more convenient to connect the keyboard to the
rear-panel leaving the front-panel USB port available for the USB flash drive.
Rear-panel PS/2 connectors are also provided in case you want to use a PS/2
keyboard or pointing device. Older AT style (DIN 5) keyboards will require an
adapter that is available at many computer stores.

\ USB port
USB ports

Alternate . /
Mouse \—‘ o) o (2

~_ o 6

@)

o

Alternate
Keyboard ﬁ . U

@) O

\_J —

Figure 1-3. Accessory Connections

2 Connect the optional mouse to any available USB port that is located on the
instrument including the two USB ports located on the keyboard.
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Installing the 86100C
Step 5. Connect a printer (Optional)

Step 5. Connect a printer (Optional)

Perform this step if you plan to connect a printer directly to the serial, parallel,
or USB ports that are located on the 86100C rear panel. If you have a parallel
(Centronics) printer, you will need a parallel printer cable, such as an C2950A
(2 m) or C2951A (3 m) cable. If you have a serial printer, you will need a 9-pin
to 25-pin serial printer cable, such as an 34398A cable, plus the 34399A
adapter kit. Some printers may require other cable configurations, but the
86100C has a 9-pin serial connector.

= Attach the required parallel or serial printer cable between your printer and the
86100C’s rear-panel connector.

Serial
Port

Parallel
Port

T O > 0O )

O [ o)

Figure 1-4. Location of Parallel and Serial Printer Ports

Support for printers with Plug and Play support will automatically be installed
when the instrument is first turned on. For other printers, use the Add Printer
Wizard from the Windows XP desktop. From the Windows Start menu, click
Printers and Faxes, and then click Add a printer.
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Installing the 86100C
Step 6. Connect the power

CAUTION

CAUTION

Step 6. Connect the power

Always use the three-prong AC power cord supplied with this instrument.
Failure to ensure adequate earth grounding by not using this cord may cause
product damage.

Do not connect ac power until you have verified the line voltage is correct as
described in Table 1-3. Damage to the equipment could result.

Connect the line cord as shown in the figure below.

Line cord

/

(O —> 0O ]]

O
O

Figure 1-5. Line Cord Connector on 86100C Rear Panel

The 86100C automatically adjusts for line input voltages in the range of 100 to
240 VAC. There is no voltage selection switch. The line cord provided is
matched by Agilent to the country in which the order originates. Refer to
Table 1-4, “Available Line Cords,” on page 1-14 for a list of other available line
power cords.
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CAUTION

Installing the 86100C
Step 6. Connect the power

This instrument has autoranging line voltage input. Be sure the supply voltage
is within the specified range.

Table 1-3. Line Power Requirements

Power 115 VAC: 110 VA MAX. / 60 WATTS MAX. / 1.1 A MAX.
230 VAC: 150 VA MAX. / 70 WATTS MAX. / 0.6 A MAX.
Voltage nominal: 115 VAC / 230 VAC CAT Il

range 115 VAC: 90-132 V
range 230 VAC: 198-254 V

Frequency nominals: 50 Hz / 60 Hz
range: 47-63 Hz

Windows XP registry: If the Infiniium DCA is mounted in a rack or cabinet, do
not use the system power switch to disconnect power from the instrument.
Instead, use the Infinilum DCA front-panel power switch. Using the system
power switch may corrupt the Windows XP registry requiring you to perform
the recovery procedure to restore normal operation to the Infiniium DCA.
Refer to “To recover the 86100C Drive-C” on page 2-24.
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Step 6. Connect the power

Table 1-4. Available Line Cords

Length

Plug Type Cable Part No. Plug Description (infcm) Color Country
250V 8120-1351 Straight *BS1363A 90/228 Gray United Kingdom, Cyprus,
@ 81201703 90° 90/228 MintGray ~ higeria Zimbabwe,
Singapore
125V 8120-1369 Straight *NZSS198/ASC 79/200 Gray Australia, New Zealand
90°
8120069 87/221 Mint Gray
250V 8120-1689 Straight *CEE7-Y11 79/200 Mint Gray East and West Europe,
8120-1692  90° 79/200 MintGray ~ Saudi Arabia, So. Africa,
India (unpolarized in many
8120-2857p Straight (Shielded) 79/200 Coco Brown nations)
125V 8120-1378 Straight *NEMA5-15P 90/228 Jade Gray United States, Canada,
8120-1521  90° 90/228 Jade Gray Mexico, Philippines,
Taiwan
8120-1992 Straight (Medical) UL544  96/244 Black
250V 8120-2104 Straight *SEV1011 79/200 Mint Gray Switzerland
8120-2296 1959-24507 79/200 Mint Gray
Type 12 90°
220V 8120-2956 Straight *DHCK107 79/200 Mint Gray Denmark
% 8120-2957 90° 79/200 Mint Gray
250V 8120-4211 Straight SABS164 79/200 Jade Gray Republic of South Africa
% 8120-4600 90° 79/200 India
100v 8120-4753 Straight MITI 90/230 Dark Gray Japan
% 8120-4754 90° 90/230

* Part number shown for plug is the industry identifier for the plug only. Number shown for
cable is the Agilent Technologies part number for the complete cable including the plug.
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Step 7. Windows Setup Wizard

CAUTION

CAUTION

NOTE

NOTE

Step 7. Windows Setup Wizard

Before switching on this instrument, make sure the supply voltage is in the
specified range.

Avoid touching the screen with a sharp object, as this could result in damage to
the display. Instead, use your finger.

Several minutes will be required during this procedure to prepare Windows XP
using the Windows XP Setup Wizard.

During the following steps, you will be instructed to “click” with the pointing
device. You can use a mouse (if you connected it) or you can touch the screen
with your finger.

Press the ON/OFF switch, @), located at the lower left-hand corner of the
front panel.

é h

ks o
1

"
\ _/

Figure 1-6. ON/OFF Switch

Wait until the Welcome to the Windows XP Setup Wizard appears as shown in
the following figure.
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Step 7. Windows Setup Wizard

Figure 1-7. Windows XP Setup Wizard

3 Click Next to display the License Agreement.

Figure 1-8. Windows XP License Agreement

4 Select “I accept this agreement” and then click Next.
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Installing the 86100C
Step 7. Windows Setup Wizard

5 Enter your name and the name of your organization or company. Click Next.

Figure 1-9. Personal Information Setup

6 Click Next.

7 Adjust the date, time, and time zone as needed in the displayed screen. Check
automatic clock adjust for daylight saving changes, if it applies to your location.

Figure 1-10. Date, Time, and Time Zone
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Step 7. Windows Setup Wizard

8 Click Next. The setup will take a few moments to complete and to automatically
restart the instrument. In about one or two minutes, you should see the 86100C
screen screen, as shown in the following figure.

“5 Fle Control setup  Measure  Calbrate  Utilities  Help 230ct2003 10:55 _|
Ozcillozcope hode . . .

Time

l

Amplitude

b _
LT

Rise Time

li

Fall Time:

A

)

itter RS
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%

R

2

Period v,

Time: 5000 ps/div. Trig: Free Runj 'v_‘ Fatfem

il

Figure 1-11. The 86100C Display
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Lock
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CAUTION To ensure proper operation of the 86100C, read “Avoid changing these
Windows system settings” on page 2-20.

NOTE When you press the ON/OFF switch to turn the instrument off, there is a small
time delay before you'll see a change on the instrument. This is normal and
does not indicate a problem.

1-18



Installing the 86100C

Step 8. Install a feature license (Optional)

Step 8. Install a feature license (Optional)

If you ordered an optional feature, such as Option 200 Enhanced Jitter Analy-
sis, with your 86100C, it was probably installed at the factory. If you ordered it,
but it wasn't installed, you received a Software Entitlement Certificate that

you must use to install the license on your 86100C.

To confirm if your license was installed

1 On the 86100C, click Licenses on the Utilities menu.

2 Check the installation status of the license in the Licenses dialog box.

Licenses m

Features That Require a License {click on Feature For more options):

Feature | ersion | Skakus

Opt, 100; Jitker Analysis 1.0 Mot Installed
Opt, 200; Enhanced Jitter Analysis 1.0 License installed
Opt, 201: Advanced Waveform Analysis 1.0 License installed

Tl fles are
ALt Eeates..

Tainstall a license For a feature, follow these steps:
1) Obtain a license file for the desired Feature
2} Click ko highlight the Feature from the list above
3} Click on the [Install License For Feature, ..] button and Follow the instructions

To obtain a license file, contact your local Agilent sales representative and purchase a Software Entitlement. Certificate
for the desired Feature, ‘With the certificate, go to the website:

http://www agilent.com/find/softwarelicense
Follow the instructions on this website, When prompted for the Host ID and Serial #, enter the values:

Host ID:  D030640223AB
Serial #:  US43420056

‘fou will receive the license file by e-mail. Install this license file using the steps described above,

Figure 1-12. Licenses Installed Status

License installed

3 If the license that you purchased is installed, no further action is required.
Continue with “Step 9. Calibrate the touch screen” on page 1-22. If your license
was not installed, continue with “To install a license” on page 1-20.
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Step 8. Install a feature license (Optional)

To install a license

1 Onthe 86100C, click Licenses on the Utilities menu. Write down the HostID and
Serial # identifiers listed on the displayed dialog box. You will need this
information in the next step.

2 Go to the following web site to obtain your license file. You will need to enter
the HostID and Serial # identifiers for your 86100C. The license file will be sent
to you via email.

www.agilent.com/find/softwarelicense

3 After you receive your license file, copy the file to a memory location that is
available to the 86100C. This could be an external USB device (for example,
flash drive or CD drive) or a network drive.

4 Onthe 86100C, click Licenses on the Utilities menu to view the Licenses dialog
box.

5 Select the feature that you want to activate and then click Install New License.
6 In the Install New License dialog box, do one of the following:
= If the license file is available to the 86100C, click Browse for License File,
find the file, and then click Install This License File.
e @ ffi N oo

Erowse for
License File

i

Selected License File:
F.\JimerAnalysis Jic

Install This
License File

4

IF the physical media required ko transfer the licanse file ko this Infiniium DCA
is not available to you, there is an alternative installation method availatle.
although not preferred, it is possible to instal the license by diectly entering
its 60 digit key code.

Enter 60 Digit Key
ode...

\:

Figure 1-13. Install New License Dialog Box

< If the license file is not available to the 86100C, manually enter a 60-digit key
code. Manually entering the key code fully fulfills the installation require-
ments. Open the license file on your PC using a text editor such as Notepad.
Look for the string SIGN= which marks the beginning of the 60-digit key
code, as shown in the following picture. In the Install New License dialog
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Step 8. Install a feature license (Optional)

box, click Enter 60 Digit Key Code and enter your key code. The letters in
the key code are not case sensitive, so you can enter letters in either upper
or lower case.

&} Jitteranalysis.lic - Notepad -0l x|
File Edit Format Help
FESTURE Jdittertnalysis agqilent 1.0 permanent uncounted ;I

HOSTID=012345678901 TS_OK SIGN="0123 4567 G9%AE CDEF 0123 4567 85946
COEF 0123 4547 8948 CODEF 0123 4567 89P.B|"
=l

Figure 1-14. Example of the contents of a license file

Enter License Key

Enter license key For Feature: Jitler Analysis 1.0

The license File that you received from GSDC is a text readable file, Using a
program that can display text files {such as Notepad) look at the contents of the
license: file. In this File you will find & code that begins with the header:

§IGN=

Following this header is the 60 digit key code required o instal this licenss.

Enter that €0 digit key code here:

[T T 7T 7 T T
[ T 1 7 0 0T 0 I

Inst=l Nfietcense

Figure 1-15. Enter License Key Dialog Box
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Step 9. Calibrate the touch screen

Step 9. Calibrate the touch screen

The touch screen configuration utility aligns and orientates the touch screen
with the display so that when you touch an element on the display screen, the
instrument can detect the task that you want to perform. The display will
always function as a touch screen, even when a mouse and keyboard are con-
nected.

1 On the Utilities menu, choose Touch Screen Config. The Pointer Device
Properties dialog box appears.

2 Click Calibrate.

%, Pointer Device Properties

Devices | Hardware | Settings | Advanced | Everts | General | windows | Calibration | Status | about |

The following devices are installed

Add..

Modiy
{ \ } Femove.. |

Caitrgte | Test | oK Cancel || Ay [ Hel |

Calibrate

Figure 1-16. Pointer Device Properties Dialog Box

3 Touch the center of the [0 as it moves on the display.

The calibration will time out within 10 seconds if you do not touch the center
of the [. You can also press Esc on an optional keyboard to exit the touch
screen calibration.
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Step 9. Calibrate the touch screen

X

Device 1

Touch the center of each cross as it appears
Calibration will terminate if no touch
is received within 10 seconds
Press escape to abort the calibration process

Figure 1-17. Calibration Screen

4 Each time that you touch the screen, an audible beep is heard. If you want to
turn the audible click sound off, select the Advanced tab and clear the Sound
selection. The touch sound stops as soon as the Pointer Device Properties
dialog box is closed.

5 Click OK to close the dialog box.
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Step 10. Avoid costly repairs

CAUTION

CAUTION

Step 10. Avoid costly repairs

é h

. _

Figure 1-18. Avoid Costly Repairs

Refer to the “Connector Care” on page 1-35, before making any electrical or op-
tical input connections.

Electrical channel input circuits and the trigger input circuit can be damaged
by electrostatic discharge (ESD). Therefore, avoid applying static discharges
to the front-panel input connectors. Prior to connecting any coaxial cable to
the connectors, momentarily short the center and outer conductors of the
cable together. Avoid touching the front-panel input connectors without first
touching the frame of the instrument. Be sure that the instrument is properly
earth-grounded to prevent buildup of static charge. Wear a wrist-strap or heel-
strap.

Optical channel fiber-optic connectors on plug-in modules are easily damaged
when connected to dirty or damaged cables and accessories. When you use
improper cleaning and handling techniques, you risk expensive instrument
repairs, damaged cables, and compromised measurements. Before you connect
any fiber-optic cable to the 86100C, refer to information in the online help.
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NOTE

CAUTION

Step 11. Calibrate the modules

This is the last step required for installing the 86100C and preparing it for use.
Additional procedures in this section are provided, if needed. To learn about
using your 86100C, be sure to read Chapter 2, “Using the 86100C” and the
instrument’s built-in Help system.

A module calibration establishes calibration factors for all installed modules.
The calibration factors compensate for imperfections in the measurement sys-
tem (for example, variations due to ambient temperature), resulting in the
best instrument precision. It is recommended that you perform this calibration
routinely for best measurement accuracy.

The module calibration is recommended whenever the following occurs:
Instrument power has been cycled
A module has been removed and then reinserted

A change in the temperature of the mainframe exceeds 5°C compared to the
temperature of the last vertical (amplitude) calibration (AT > 5°C)

The time since the last calibration has exceeded 10 hours

Refer to the Help for more information about instrument calibrations.

Allow the instrument, with modules installed, to warm up for a period of at least
one hour before performing a vertical calibration. This ensures that the module
reaches its equilibrium temperature.

Electrical channel input circuits and the trigger input circuit can be damaged
by electrostatic discharge (ESD). Therefore, avoid applying static discharges
to the front-panel input connectors. Prior to connecting any coaxial cable to
the connectors, momentarily short the center and outer conductors of the
cable together. Avoid touching the front-panel input connectors without first
touching the frame of the instrument. Be sure that the instrument is properly
earth-grounded to prevent buildup of static charge. Wear a wrist-strap or heel-
strap.

To perform a module calibration
On the Calibrate menu, choose All Calibrations.

The All Calibrations dialog box opens. This dialog box allows you to view
the calibration status of modules and initiate the calibration.
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2 Touch the Modules tab.

The Modules tab opens and allows you to perform a module calibration on
either the left or right module.

3 Touch the Calibrate Module button (located at the bottom of the tab) for the
module you need to calibrate. This starts the Module calibration.

All Calibrations &7

Modules Mainframe and Skew Extinction rafio Probe Opfical channel

~LUser Module Calibration

Right Module User calibration is recommended

LUser module calibration is recommended:
» Elapsed cal ime has exceeded 10 hours

e (B AR Calloration Date 14 May 2002 15:40

Elapsed Cal Time 216:00 (hours:minutes)
Left Chan Cal AT 0z2°C

% Right Chan Cal AT~ 0.2 °C
Model 547544
Serial Mumber LS40230202

hodule...

Figure 1-19. Calibrate Module Button

4 Remove all external devices and signals from the module.

The module calibration uses known signal levels in the instrument. Introduc-
ing an outside signal source will interfere with the calibration factors and
decrease the accuracy of the calibration.

5 Touch Continue. A progress indicator appears.
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Module Calibration

Disconnect evenything from the right module

Confinue

Cancel

Do not remave module!

¢ Caneel |

Calibration Progress:

I

Figure 1-20. Calibration Progress

Installing the 86100C
Step 11. Calibrate the modules

6 After the calibration completes, choose All Calibrations on the Calibration

menu.

7 The Modules tab shows the status of the calibration and should indicate that

the “Current user module calibration is valid.”
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To configure a LAN connection

You can configure the 86100C on a LAN for file sharing and using network
printers. If you do not know how to set up a network, contact your network
administrator or use the Windows XP Professional on-line help. The network
setup is different for every company. Your company’s network administrator
can set up your instrument with the appropriate client, protocol, and configu-
ration for your local area network (LAN). If you plan on sharing your instru-
ment’s hard disk drive with other computers on your LAN, the network
administrator should enable file sharing as part of the network setup.

1 Connect your LAN cable to the rear-panel RJ-45 connector.

LAN
Connection

O
O

- 0 [ 0

Figure 1-21. LAN Connector

2 Start the 86100C.
3 Click Exit on the File menu to close the 86100C DCA application.
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4 Click Start to view the Windows Start Menu.

i Jis .J‘ Administrator

b Internet

Internet Explorer
v-.J E-mail
'.@ Tour Windows XP
@ ‘Windows Movie Maker

© Files and Settings Transfer
‘Wizard

All Programs b

|1 <y My Recent Documents »

gﬂ My Computer
@ Control Panel

\]:é Printers and Faxes
9) Help and Support
’-_) Search

E Run...

&
‘ﬁ 86100 Infinium DCA

og OFff |® | Turn OFf Computer

Figure 1-22. Windows Start Menu

Installing the 86100C
To configure a LAN connection

5 Click My Computer to set up a network connection, map a network drive, or
share an 86100C folder. You can share any folder on the USER (D:) drive. Click

Help and Support to get detailed information.
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To connect an external display

You can connect a VGA-compatible display to the 86100C to provide a larger
viewing area of the screen.

Connect the display cable to the rear-panel VGA connector. This connector is
labeled External Display on Figure 1-23.

Tighten the retaining screws.
Connect the external display.

The rear-panel VGA connector labeled Second Desktop Connection on
Figure 1-23 is provided for use of the Windows second desktop feature. Refer
to Windows XP Help for information on using a second desktop.

Extemal
Display

(T O —> O ]

.

O / I O
/

Second Desktop
Connection

Figure 1-23. External Monitor Connector
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WARNING

CAUTION

To clean the 86100C

Clean the 86100C using a soft cloth slightly dampened with a mild soap and
water solution.

To prevent electrical shock, disconnect the Agilent Technologies
model 86100C from mains before cleaning. Use a dry cloth or one
slightly dampened with water to clean the external case parts. Do not
attempt to clean internally.

Do not use too much liquid in cleaning the oscilloscope. Water can enter the
front panel, damaging sensitive electronic components.

1-31



Installing the 86100C
To use the removable hard disk option

To use the removable hard disk option

The removable hard disk option, 86100C-090, is designed for 86100C instru-
ments that are used in a secure environment. Because the hard disk is easily
removed from the instrument, you can protect any sensitive data.

The removable hard disk option comes with two hard disks. One is installed in
the instrument, and one is provided separately. When shipped from the fac-
tory, both hard disks include identical operating system, applications, factory
calibration, and licensing files. You simply exchange the hard disks, and the
instrument is ready to use.

Both drive C (INFINIIUM) and drive D (USER) are located on the hard disk.
Drive C contains the operating system, the 86100C application, and any fac-
tory installed or user installed applications. Drive C also contains factory cali-
bration data and application licenses, which are automatically backed up to
drive D. Drive D contains backup files and user files including data files.

To exchange the removable hard disks
Turn the 86100C on.

If you're removing the 86100C from a secure area, press the Default Setup key
two consecutive times. (Press Default Setup, then immediately press Default
Setup again.)

The instrument always maintains its current settings in non-volatile RAM, so
that when you power up the instrument, the settings will be the same as when
it was last powered off. This step deletes the current settings in non-volatile
RAM.

If the instrument has been returned from Agilent with a new mainframe
calibration, you must save a copy of the calibration file from the current hard
disk. Later in this procedure, you will install this file on the secure hard disk.

a On the 86100C, click All Calibrations on the Calibrate menu. Click the Main-
frame and Skew tab. Record the calibration date for use later in this proce-
dure. See Figure 1-24 on page 1-33.

Calibration date:

b Close the All Calibrations dialog box.

¢ Click Exit on the File menu to close the DCA application.
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status message

calibration date

\
\

NOTE
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To use the removable hard disk option

All Calibrations i

Modules Mainframe and Skew Extinction ratio Probe Optical channel

—Service Mainframe Timebase Calibration

™ Status  Cument service mainframe tmebase calibration is valid

Cal 4T 10°C
\

™~ Calibration Date 05 har 2004 09:17

LUser Mainframe Skew
Adiust...

Figure 1-24. Mainframe timebase calibration status and date

d From the Windows Start menu, click My Computer.

e Enter the path, c:\scope\cal, in the address line as shown in Figure 1-25 on
page 1-34. Then, press enter to locate the file, framecal.dat.

The folder, c:\scope\cal, is hidden and will not be shown if you browse for it.

f Copy the file, framecal.dat, to an external USB memory device.
Turn off the 86100C.

5 On the 86100C's rear panel, turn the thumbscrew to loosen and move the tab

covering the hard disk.
Use one of the supplied keys to unlock the hard disk.
Pull out the hard disk and disconnect the two cables.

Install the alternate hard disk. Connect the two cables, lock the lock, and
secure the tab covering the hard disk.
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! My Computer
File Edit ‘iew Favorites Tools Help o

<) Back J l’ ,..._\J Search - Folders V

ciiscopetcal o | —) Go
A~

# | Hard Disk Drives

c:\scopelcal

System Tasks

, Yigw system w TNFINIIUM (C:)

information

Ly Add or remave
programs R

G- Change a setting E@ UISER (D)

Other Places Devices with Removable Storage

\Q Iy Metwork Places

=) My Documents @ - i :
= L 2 CD-RW Drive (E1)
G- Contral Panel \4@ b

< |[*

Figure 1-25. Locating the file framecal.dat

If you saved the mainframe calibration file in Step 3, perform these steps:

a

Turn on the 86100C, and click Exit on the File menu to close the DCA appli-
cation.

From the Windows Start menu, click My Computer.

Locate the file, framecal.dat, that you copied to your external USB memory
device.

Copy this file and paste the file into the folder, c:\scope\cal. Locate the folder
by entering the path, c:\scope\cal, in My Computer as shown in Figure 1-25.
Click OK to overwrite the current file.

Turn the 86100C off and then on again.

Click All Calibrations on the Calibrate menu. Click the Mainframe and Skew
tab.

Confirm that the displayed calibration date is the same date that you record-
ed in Step 3. Verify that the displayed status message reads “Current service
mainframe timebase calibration is valid.” See Figure 1-24 on page 1-33.
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Connector Care

Damage to 86100C electrical and fiber-optic input connectors (as well as con-
nectors on calibration and verification devices, test ports, cables, and other
devices) can degrade measurement accuracy and damage instruments.
Replacing a damaged electrical and fiber-optic connectors can cost thousands
of dollars, not to mention lost time! This expense can be avoided by observing
some important precautions.

After reading the this overview, refer to Connector Care in the 86100C Help
for detailed information. You'll find procedures for connecting and cleaning as
well as accessories. To access the Help, turn on the 86100C and click Con-
tents on the Help menu.

Connector

Care ™~_

B Infiniium DCA Help Contents  (Revision A.04.10) |

LContentz|  |ndex Back Frint | Glogzary | Minimize | Close

N ew Features

S =] B sl )

Getting Started  Instrument Using the Setup Guide  Files. Printing,
Modes Instrument and Networks
Connector Modules Specifications Messages and Technical
Care Errors Support

(0 (I ([ (I (0 () (O [
(] (1o (=1 (1o] (=] (] (] (o (] (3] (3] (] (2]

Index {Please click a letter)

Figure 1-26. Connector Care Information in Help
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WARNING

CAUTION

CAUTION

Handling and storage

Visual inspection

Cleaning

Electrical Connections

If flammable fluids are used to clean connectors, the fluid shall not be
placed on the instrument during, use or when connected to mains
voltage. Cleaning the connectors shall take place in ventilated area to
allow fluid vapors to dissipate, and reduce the risk of fire.

The input circuits can be damaged by electrostatic discharge (ESD).
Therefore, avoid applying static discharges to the front-panel input and trigger
connectors. Before connecting any coaxial cable to the connectors,
momentarily short the center and outer conductors of the cable together. Avoid
touching the front-panel input connectors without first touching the frame of
the instrument. Be sure the instrument is properly earth-grounded to prevent
buildup of static charge.

Electrostatic discharge (ESD) can damage or destroy electronic components.
Coaxial cables with both ends unconnected may store electrostatic charges.
Before connecting any coaxial cable of this sort to a device or instrument,
momentarily short the center and outer conductors of the cable. When making
connections, ensure the proper use of a grounded, resistor-isolated wrist strap.

Advances in measurement capabilities make connectors and connection tech-
niques more important than ever. Observing simple precautions can ensure
accurate and reliable measurements.

Keep connectors clean

* Extend sleeve or connector nut

* Use plastic endcaps during storage

« Do not touch mating plane surfaces

* Do not set connectors contact-end down

« Inspect all connectors carefully before every connection
« Look for metal particles, scratches, and dents
« Do not use damaged connectors

e Clean with compressed air first

« Clean the connector threads

« Do not use abrasives

« Do not get liquid onto the plastic support beads
* Making connections

= Align connectors carefully
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Using Connector
Savers

3.5 mm and SMA
Connectors

CAUTION

CAUTION

1.85 mm Connectors

CAUTION

Installing the 86100C
Electrical Connections

* Make preliminary connection lightly

e To tighten, turn connector nut only

« Do not apply bending force to connection

< Do not over tighten preliminary connection

< Do not twist or screw in connectors

< Do not tighten past the "break" point of the torque wrench

Connector savers are useful in prolonging instrument life and ensuring better
quality measurements. Refer to the online help for a list of commonly used
connector savers.

Precision 3.5 mm microwave connectors are compatible with an SMA connec-
tor within its specification. Due to the variable quality of the SMA connector,
mating with an SMA can sometimes cause severe damage to the 3.5 mm con-
nector. To ensure measurement accuracy, use 3.5 mm precision connectors.
However, you can use SMA connectors if special care is taken when mating the
connectors, and all connectors are undamaged and clean. Before each use,
check the mechanical dimensions of all connectors with a connector gauge to
make sure that the center conductors are positioned correctly.

A male SMA connector pin that is too long can smash or break the delicate
fingers on the precision 3.5 mm female connector.

Some precision 3.5 mm female connector fingers are very tight and can pull the
center pin of their mates out past specifications when the connectors are
disconnected. If such a male pin is inserted into a female connector, it can
cause considerable damage by pushing the female center conductor back too
far. Be aware of this possibility and check all connectors before mating them
again.

The 1.85 mm connectors are used with many of the Agilent 86100 series plug-
in modules and remote heads.

Failure to follow the guidelines for proper connector handling and avoiding
electrostatic discharge (ESD) can result in severe damage to the product. In
some cases, the 1.85 mm connector is an integral part of the electrical sampler
device. Therefore, by using improper cleaning and handling techniques, you
risk expensive instrument repairs.

« Observe the connection techniques listed in the 86100C help.

« Clean and inspect (visually and mechanically) all connectors.

= Align connectors carefully. Look for at physical contact at all points on the
mating plane surfaces.
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« Make a gentle, preliminary connection. If initial alignment is correct the con-
nector nut should thread on to the female outer conductor with minimal fric-
tion.

< If friction is encountered, STOP! Disassemble the connector immediately
and determine the cause of the problem. Failure to observe this caution will
lead to almost certain damage to one or both of the connectors.

« When you make a connection, turn only the connector nut. Do not rotate a
device when you make a connection and do not apply lateral or horizontal
(bending) force.

WARNING

CAUTION

Fiber-Optic Connections

If flammable fluids are used to clean connectors, the fluid shall not be
placed on the instrument during, use or when connected to mains
voltage. Cleaning the connectors shall take place in ventilated area to
allow fluid vapors to dissipate, and reduce the risk of fire.

Never use metal or sharp objects to clean a connector and never scrape the
connector.

Avoid matching gel and oils.

Agilent Technologies strongly recommends that index matching compounds
not be applied to their instruments and accessories. Some compounds, such as
gels, may be difficult to remove and can contain damaging particulates. If you
think the use of such compounds is necessary, refer to the compound
manufacturer for information on application and cleaning procedures.

When inserting a fiber-optic cable into a connector, gently insert it in as
straight a line as possible. Tipping and inserting at an angle can scrape material
off the inside of the connector or even break the inside sleeve of connectors
made with ceramic material.

When inserting a fiber-optic connector into a connector, make sure that the fi-
ber end does not touch the outside of the mating connector or adapter.

Avoid over tightening connections.

Unlike common electrical connections, tighter is not better. The purpose of
the connector is to bring two fiber ends together. Once they touch, tightening
only causes a greater force to be applied to the delicate fibers. With connec-
tors that have a convex fiber end, the end can be pushed off-axis resulting in
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misalignment and excessive return loss. Many measurements are actually
improved by backing off the connector pressure. Also, if a piece of grit does
happen to get by the cleaning procedure, the tighter connection is more likely
to damage the glass. Tighten the connectors just until the two fibers touch.

Keep connectors covered when not in use.

Use fusion splices on the more permanent critical nodes. Choose the best con-
nector possible. Replace connecting cables regularly. Frequently measure the
return loss of the connector to check for degradation, and clean every connec-
tor, every time.
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Returning the Instrument for Service

The instructions in this section show you how to properly package the instru-
ment for return to an Agilent Technologies service office. If the instrument is
still under warranty or is covered by an Agilent maintenance contract, it will
be repaired under the terms of the warranty or contract. If the instrument is
no longer under warranty or is not covered by an Agilent maintenance plan,
Agilent will notify you of the cost of the repair after examining the unit.

When an instrument is returned to an Agilent service office for servicing, it
must be adequately packaged and have a complete description of the failure
symptoms attached.

When describing the failure, please be as specific as possible about the nature
of the problem. Include copies of any instrument failure settings, data related
to instrument failure, and error messages along with the instrument being
returned.

Please notify the service office before returning your instrument for service.
Any special arrangements for the instrument can be discussed at this time.
This will help the Agilent service office repair and return your instrument as
quickly as possible.

Call Center

Contacting Agilent Technologies

For technical assistance, contact your local Agilent Call Center.
In the Americas, call 1 (800) 829-4444
In other regions, visit http://www.agilent.com/find/assist

Before returning an instrument for service, you must first call the Call Center
at 1 (800) 829-4444
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CAUTION

CAUTION

Preparing the instrument for shipping

Write a complete description of the failure and attach it to the instrument.
Include any specific performance details related to the problem. The following
information should be returned with the instrument.

* Type of service required.
« Date instrument was returned for repair.
« Description of the problem:
« Whether problem is either constant or intermittent.
« Whether instrument is temperature-sensitive.
* Whether instrument is vibration-sensitive.
« Instrument settings required to reproduce the problem.
* Performance data.
 Company name and return address.
« Name and phone number of technical contact person.
* Model number of returned instrument.
< Full serial number of returned instrument.
« List of any accessories returned with instrument.
« The original cal data disks.

Cover all front or rear-panel connectors that were originally covered when you
first received the instrument.

Cover electrical connectors to protect sensitive components from electrostatic
damage. Cover optical connectors to protect them from damage due to physical
contact or dust.

Instrument damage can result from using packaging materials other than the
original materials. Never use styrene pellets as packaging material. They do not
adequately cushion the instrument or prevent it from shifting in the carton.
They may also cause instrument damage by generating static electricity.

Pack the instrument. Use original packaging or comparable. Original materials
are available through any Agilent office. Or, use the following guidelines:

« Wrap the instrument in antistatic plastic to reduce the possibility of damage
caused by electrostatic discharge.

e For instruments weighing less than 54 kg (120 Ib), use a double-walled, cor-
rugated cardboard carton of 159 kg (350 Ib) test strength.

e The carton must be large enough to allow approximately 7 cm (3 inches) on
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all sides of the instrument for packing material, and strong enough to accom-
modate the weight of the instrument.

e Surround the equipment with approximately 7 cm (3 inches) of packing ma-
terial, to protect the instrument and prevent it from moving in the carton. If
packing foam is not available, the best alternative is S.D-240 Air Cap™ from
Sealed Air Corporation (Commerce, California 90001). Air Cap looks like a
plastic sheet filled with air bubbles. Use the pink (antistatic) Air Cap™ to
reduce static electricity. Wrapping the instrument several times in this ma-
terial will protect the instrument and prevent it from moving in the carton.

4 Seal the carton with strong nylon adhesive tape.
5 Mark the carton “FRAGILE, HANDLE WITH CARE".
6 Retain copies of all shipping papers.
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A Quick Tour

The Infiniium DCA is designed to measure a variety of high speed digital com-
munication waveforms. You can operate the Infinilum DCA in any of four
instrument modes:

Eye/Mask Mode for eye diagram analysis and standards testing (for example,
SONET/SDH, Gigabit Ethernet, and Fiber Channel).

Jitter Mode. Requires Option 001 Enhanced Trigger and Option 200. Option
200 involves purchasing licenses which can be added after the initial instru-
ment purchase.

TDR/TDT Mode for time domain reflectometry measurements

Oscilloscope Mode (DC to > 70 GHz)

Oscilloscope  TDR/TDT Eye/Mask Jitter
mode mode mode mode

\\ //

@..

T AT

= 5 Sob
07a0 @ 0

["“;‘“‘5“ | p——

Figure 2-1. The Four Instrument Modes
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Use the touch screen
You can explore the instrument’s menus and change its settings by touching
the display, clicking a mouse, or using front-panel knobs and buttons.

Measurement Instrument Date and Minimize
toolbar menus time displays button

n g . M y
s File Control  Setup  Measure  Calbrate  Utilities  Help ] 20 Sep 2004 12:450 _|

TTEr nnre

1] P PI W {
I, It | 5: 1,05 M Freq: 321 kHe [Dick ko Crengs]

3 ps E

AT resuts W Fron U — Tl

- PJ Sub-Rate Components PJ Asynchronous Component s

Eit BOD f5 @ ratef127 520 ps @ 38.321 kHz Resalvel  Sefup
450 T3 B rates1B 230 fs B Urable 1o Resalve J_]Fre g _]& Infa
JJIlru 2T Fe 0 kst odo on fe [ 1okl o o Bacolwe

i
Compostte. ) (@hConimlis at/imit
/

A0 LA 00 i div Time: 167 ps/div Trig: Pattem —~
0.0 ‘/_ézsm my / } Mot Present § _9“0‘ Present | Dejgy:40 1543 ns | Bit 0, | ES{E'”

a

=

Status Measurement Time / div Pattern Lock
message results and delay button button
area
Channel Trigger mode
configuration button
buttons

Figure 2-2. Display
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You must provide a trigger input signal

Because high-speed oscilloscopes are not capable of triggering directly on a
test signal, you must first connect an external timing reference signal to the
front-panel trigger input connector. This input allows the Infiniium DCA to
synchonize to the input signal. Clock recovery modules (for example, the
83495A) are available to recover the clock from the test signal.

You can select free-run triggering when an external trigger is unavailable,
however, you will only be able to view the waveform for amplitude information
only without any timing information. This is an easy way to examine the ampli-
tude of a signal.

/ \ \

Trigger source Trigger input Optical and electrical
button signal inputs

Figure 2-3. Trigger Controls
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To learn more about your Infiniium DCA

< Refer to the online Help, which contains information that would normally be in
the user’s guide

= Visit our website at http://www.agilent.com. Use the keywords “Infiniium
DCA” or “86100C” in your search.

Horizontal Default
Autoscale Scale Setup
Button Control . Button
Horizontal
Operating Mode Acquisition P osition UsB
Select Buttons Controls Control Port

Calibration
———————————— Output
\ Local/Remote
I
Select Button
NE [ Channel
Select Buttons
@D 1
[T Vertical Scale
Controls
&
K [ Offset
S oo S . ::: — Controls
® 0 0,0 0 ©~(O)s AN
,/ / / Optical/
Electrical
/ / / Inputs
AC Marker Trigger Quick Probe Power
Power Controls Controls Measure Output for

Button Active Probe

Figure 2-4. Front-Panel Features
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Plug-in Modules

The Infiniium DCA holds up to two plug-in modules, which can provide up to
four measurement channels. Each input channel has its own vertical controls.
The amplitude scale knob adjusts the amplitude scale used for the input chan-
nel. Use the amplitude offset knob to position the displayed signal. You can
also set the amplitude scale and offset to specific values by touching of chan-
nel buttons shown to at the bottom of the display.

CAUTION Electrical channel input circuits and the trigger input circuit can be damaged
by electrostatic discharge (ESD). Avoid applying static discharges to the front-
panel input connectors. Prior to connecting any coaxial cable to the
connectors, momentarily short the center and outer conductors of the cable
together. Avoid touching the front-panel input connectors without first
touching the frame of the instrument. Be sure that the instrument is properly
earth-grounded to prevent buildup of static charge. Wear a wrist-strap or heel-
strap.

) Second
Serial Parallel Desktop External
Alternate Port Port Connection Display
Pointing
Device /
Trigger Gate
Input ﬁ H
Alternate _—""]
Keyboard O O
- o) [ o)

Figure 2-5. Rear-Panel Features
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Optical channel fiber-optic connectors are easily damaged when connected to
dirty or damaged cables and accessories. When you use improper cleaning and
handling techniques, you risk expensive instrument repairs, damaged cables,
and compromised measurements. Before you connect any fiber-optic cable to
the digital communications analyzer, refer to “Connector Care” on page 1-35.

You can use 8348x and 5475x series plug-in modules. In addition to a complete
line of modules designed specifically for this instrument, modules designed for
use with Agilent 83480A and 54750A mainframes can also be installed into the
Infiniium DCA. (The 83495A clock recovery module is the exception to this
numbering scheme and was designed specifically for use with 86100-series
mainframes.) The 8348x and 5475x series plug-in modules are equipped with
a trigger input on the individual module front panels. Repeatedly press the
Infiniium DCA's front-panel Trigger Source button until the label for the
desired trigger source is lit.

Automatic Time Time Channel
scaling scale offset select

| _——— Amplitude
scale

\ Locking

SCrews

Figure 2-6. Amplitude and time adjustments
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Eye/Mask Mode

Eye/Mask Mode

The Eye/Mask mode allows you to per- e i i s G e o5 sl 2]
form NRZ (Non-Return to Zero), or RZ
(Return to Zero) eye diagram mea-
surements and eye mask tests. The
eye diagram is typically produced by
triggering the instrument with a syn-
chronous clock signal.

Eye/Mask mode measurements only - e S A,

work when an eye diagram, and not a

pulse, is present on the screen. Mea- st | Yot | G | IS | s pgm | Tmo | o
surements made on a pulse waveform

while in Eye/Mask mode will fail.

Once you are in Eye/Mask mode, press the Autoscale button. This ensures
that an optimum eye diagram is displayed on the graticule. An optimum eye
diagram consists of a full display of the eye in addition to portions of the wave-
form preceding and following the eye.

When you select the Eye/Mask mode, the EyedNiask hade. Eyeshiask hiada.
measurement toolbars shown here appear. NRZ Eye Meas °
These measurement toolbars include mea- -

surements such as rise time, fall time, jitter,

and extinction ratio, as well as the mask test
start and stop controls.

Eye measurement and mask test results
appear below the display graticule. A maxi- .
mum of four eye measurement test results Mask Test
are displayed and include any failures or ]
instrument messages that may occur. e
To learn more about the Eye/Mask mode and N |
switching from NRZ to RZ measurement S
mode, consult the Help. —

=

v ez uze fl W
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To View an Eye Diagram

To View an Eye Diagram

When learning to use the instrument, practice viewing a PRBS signal, which
will have a varied number of ones and zeros and will produce a classic eye dia-
gram.

NOTE The 86100C Help contains many more measurement procedures for Eye/Mask
mode.

1 Select a DCA module that is compatible with the type of signal that you are
measuring.

2 Install the module into the DCA mainframe. You don't have to turn the
mainframe off before installing the module.

3 Connect the cable with the signal to be measured to the module's front-panel
channel input connector.

N

Connect a synchronous clock signal to the front-panel Trigger input connector.
If you don't have a synchronous clock signal, install and setup a clock recovery
module.

5 Press the Default Setup button to place the instrument in a known start-up
state.

6 Press the channel button to select the module input channel that you are using.
The channel button will be lit when a channel is selected.

| 1) L2 ) 13 4]

; ) ¥
o= - = -\_‘:.": =

7 Press the front-panel Source button to select triggering on the Front Panel
connector. If you are using a clock recovery module, select Left Module or
Right Module to use the recovered clock, and refer to clock recovery modules
for more information on using other settings.

(S_u;uﬁ Free Run Frort Panel
"-\_\_,_F".)

Left Module
Right Module

8 Click the Trigger button to open the Trigger dialog box. Or, click the Trigger
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Using the 86100C
To View an Eye Diagram

command on the Setup menu. Select the General Trigger Setup tab on the
dialog box.

Trig: Marmal
0.0

Locate the Bandwidth settings in the Trigger dialog box. Select Standard for
data rates up to 3.2 GHz. This is the default bandwidth setting. If the
instrument has the enhanced trigger installed (Option 001), select Divided for
direct or divided trigger rates between 2 GHz and 13 GHz.

Close the Trigger dialog box.
Press the front-panel Eye/Mask Mode button.

On the Setup menu, click NRZ Eye Mode for a Non-Return-to-Zero data format
or RZ Eye Mode for a Return-to-Zero data format.

Press the front-panel Auto Scale button. The eye diagram should be displayed.
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Jitter Mode

Jitter Mode

Jitter Mode is an optional feature that,

Zi e Conrol Setup Messure Calbrate Utiities Help

if installed, adds powerful jitter mea- =
surement capability to your Infiniium
DCA. Refer to “Optional Features and [ |
Licenses” on page 2-16 for informa- _%J
tion on adding this option. —
Jitter Mode measures Total Jitter (TJ) oo
- 2
as well as Jitter component such as
Periodic Jitter (PJ), Deterministic Jit- |5
ter (DJ), Data-Dependent Jitter [ e

205ep 2004 1250 =
istogram

(DDJ), Random Jitter (RJ), Duty

Cycle Distortion (DCD), and Inter-Symbol Interference (ISl).

The displayed graphs include a TJ histo-
gram, RJ, PJ histogram, DDJ histogram,
composite histogram, composite DDJ histo-
gram, and DDJ versus Bit. While in Jitter
Mode, you can view a representative eye
diagram from which the jitter measurements
are derived. You can also temporarily switch
to Eye/Mask Mode in order to view the indi-
vidual bit trajectories in the data pattern.

The 86100C uses a pattern trigger in Jitter
Mode. But, because Jitter Mode internally
generates the pattern trigger and automati-
cally detects bit rate, pattern length, and
trigger divide ratio, in most cases, you don't
need to know or to enter these values.

Jitter Mode requires measurement data in
the NRZ coding format. Measurements can
not be performed on data using RZ coding.

Waveforms

Consult the 86100C Help for more information and procedures on using Jitter

Mode.
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Using the 86100C
To measure jitter

To measure jitter

NOTE The 86100C Help contains more measurement procedures for Jitter mode.

1 Connect the data signal to a module's front-panel channel input connector, and
press the associated channel button. The channel button will be lit when a
channel is selected. Turn all other channels off.

(1) (2] |3 (a)
....R_T}g- -f-: - y '-!.:j}' -.:,H,-]!'

2 Connect a synchronous clock signal to the front-panel Trigger input connector.

3 Press the front-panel Source button to select triggering on the front-panel

connector.
@ Free Run Fort Panel
Left Module i :
+
I." . Right Module

4 Press the front-panel Jitter Mode button. After the instrument measures the
jitter components, the results are displayed in several graphs and in a table.

Jter
ko de
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Using the 86100C
Oscilloscope Mode

Oscilloscope Mode

Use the Oscilloscope mode for pulse
type waveforms that are triggered by
an external signal. Oscilloscope mode
measurements only work when a single
valued waveform, and not an eye dia-
gram, is present on the screen.

Bl Conol Setp Messwe Calbrate Uilfes Hep
Oscoscape Hode

03012003 0827 =

v

When you select the Oscilloscope

mode, the measurement toolbars shown
here appear. These measurement toolbars
include measurements such as rise time, fall

1) ROV | 3 DOIVSY | 3t | &)t | [0 0000 Tigtlema | < paten
Eile  Contral File  Control
Dscilloscope Mode Ozciloscope Mode
Time = Time =)
Amplitude =3 Amplitude -

time, overshoot, and Vp-p. All measure-
ments, with the exception of jitter, can be
performed on any of the following sources:
channels, waveform memories, and math
functions. One of the above sources must be
turned on in order to perform an oscillo-
scope measurement.

If more than one source is turned on and
you initiate a measurement, the Enter Mea-
surement Info dialog box opens. This dialog
box allows you to select the source you want
to use for the measurement.

Measurement results appear below the dis-
play graticule. A maximum of four pulse

=

Overshoot

gl

Rise Time

IZ

Fall Time

Penod

measurement test results are displayed and include any failures or instrument

messages that may occur.

To learn more about the Oscilloscope mode, consult the Online Help.
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TDR/TDT Mode

TDR/TDT Mode

The TDR/TDT mode allows you use T
time domain reflectometry (TDR) to — <
verify the proper functioning of the

physical components of your device
under test using a time-delayed electri-

&

iLE

12

Nomal

ize.

cal pulse. You can also use time domain |

transmission (TDT) to measure both il

the attenuation and propagation delay &

of your device under test. il |

TDR/TDT mode measurements are e yeren YUEE QG SRBEE DB o
made using a single-ended or differen-

tial TDR/TDT 5475x series plug-in

module.

When you select the TDR/TDT mode, the measure- Bz Cami

ment toolbar shown here appears. This measurement TDR/TDT Mode

toolbar includes measurements such as Quick TDR,
normalization, rise time, and fall time. Quick TDR
allows you to view an immediate display of the charac-
teristics of your device under test. You can also use this
toolbar to perform tasks such as setting up the stimu-
lus and destination for your measurement.

You can use markers to to verify the impedance, volt-
age, and percent of reflection of a selected point on the
waveform trace. TDR/TDT markers are initiated by
turning on the X-axis marker(s) only. The Y-axis
marker(s) will then track the waveform at the position FHEROTES.
determined by the X-axis marker. You can view the Ve l
position of the marker values in the marker values tab =
located below the display graticule.

To learn more about the TDR/TDT mode, consult the -}
Help. Fall Tme © .

Rize Time
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Using the 86100C
Quick Measure

Quick Measure

Press Quick Measure and the Infinilum DCA automatically performs four
measurements on a displayed signal. Although there is a default set of mea-
surements for each instrument mode, except Jitter mode, you can select the
measurements to fit your needs. For example, in Oscilloscope mode the
default measurements are: rise time, fall time, period, and V amplitude. In
Eye/Mask mode you can also configure Quick Measure to perform a mask test.
In Jitter mode, Quick Measure displays graphs and can not be configured.

To configure Quick Measure

* On the Measure menu, choose Quick Measure Config.

00000 ©

Quick
Measure

Figure 2-7. The Quick Measure Button
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Optional Features and Licenses

Optional Features and Licenses

You can purchase additional features that add measurement capabilities for
your 86100C. The Jitter instrument mode is an example of an added feature.
Contact your local Agilent sales representative for the latest information on
available features for the 86100C. Use the Licenses command on the Utilities
menu to manage licenses. The Licenses dialog box describes the basic steps
on how to order and install a license for a feature. It also lists all available fea-
tures including the status of each license. This allows you to quickly determine
if a feature is activated on your 86100C. To learn more about purchasing,
installing, and using a feature, consult the Help.

Licenses m

Features That Require a License {click on Feature For more options):

Feature ‘ersion Status ©

I I Ifretall Licerse
Opt. 100: Jitter Analysis 1.0 Mot Installed I FEatire.
Opt, 200; Enhanced Jitter Analysis 1.0 License installed
Opt, 201: Advanced Waveform Analysis 1.0 License installed

Tl fles are
ALt Eeates..

i

Tainstall a license For a feature, follow these steps:
1) Obtain a license file for the desired Feature
2} Click ko highlight the Feature from the list above
3} Click on the [Install License For Feature, ..] button and Follow the instructions

To obtain a license file, contact your local Agilent sales representative and purchase a Software Entitlement. Certificate
for the desired Feature, ‘With the certificate, go to the website:

http://www agilent.com/find/softwarelicense
Follow the instructions on this website, When prompted for the Host ID and Serial #, enter the values:

Host ID:  D030640223AB
Serial #:  US43420056

‘fou will receive the license file by e-mail. Install this license file using the steps described above,

Figure 2-8. The Licenses Dialog Box
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Jitter Analysis Feature

Jitter Analysis Feature

The Enhanced Jitter Analysis feature, option 86100C-200, activates the instru-
ment's Jitter Mode, which is entered by pressing the front-panel Jitter Mode
button. Jitter Mode provides powerful tools for measuring the following com-
ponents of jitter:

Total Jitter (TJ)

Deterministic Jitter (DJ)

Data-Dependent Jitter (DDJ)

Random Jitter (RJ)

Periodic Jitter (PJ) including analysis of sub-rate PJ components and
asynchronous PJ components

Inter-Symbol Interference (ISI)

Duty-Cycle Distortion (DCD)

In addition to tabular results, several graphs of jitter are provided. You can
even view the eye diagram that is used to perform the jitter measurements.
Jitter Mode requires an 86100C with Option 001, Enhanced Trigger, installed.

Advanced Waveform Analysis Feature

The Advanced Waveform Analysis feature, option 86100C-201, provides two
powerful tools for the design engineer: a Linear Feedforward Equalizer and a
MATLAB Filter. It also includes the abiltiy to import and export pattern wave-
forms. This feature requires that Option 001, Enhanced Trigger, is installed.

The Linear Feedforward Equalizer allows you to design and apply a finite
impulse response (non-recursive) digital filter to an instrument channel or
math function. With the Linear Feedforward Equalizer, you can model equal-
izer designs on an actual signal before designing any hardware. The equalizer
allows you to open a closed eye diagram on your system with the goal of a
designing a stable, compliant system.

With the MATLAB Filter application, you can design and apply software filters
to a waveform and view the real-time output on the 86100C display. Because
this application uses the product, MATLAB , which is a technical computing
language and environment, you can write your own software filter scripts. The
MATLAB Filter application does not include MATLAB. You must purchase
(www.mathworks.com) and install MATLAB separately on the 86100C.
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CAUTION

Using the 86100C
Windows XP Professional

Windows XP Professional

The 86100C is an instrument running Microsoft ® Windows ® XP Profes-
sional. You can access Windows XP Professional just as you would on your per-
sonal computer. Use Windows XP Professional to manage files and folders,
add, remove, and setup printing, configure networking, and install additional
applications. Be sure to read “Avoid changing these Windows system settings”
on page 2-20.

Help on Windows XP is available from the Windows XP Start Menu. Refer to
this help for information on adding printers and making LAN connections.

Agilent 86100C

infiniium DCA

www.agilen ns/DCA TS
il

Agilent Technologie

© Agilent Technologies 2003

Start Menu

Figure 2-9. Get Windows XP Help via the Start Menu

Although the 86100C is an instrument and not a personal computer, the oper-
ating system is accessible. This makes it possible for you to install applications
such as virus protection software. If the performance of the Infiniium DCA
application decreases while running other applications, you may need to close
those applications that are demanding processor resources. It is also sug-
gested that you schedule automatic virus scans for times when you are not
making measurements.

If you install an application, it is possible that the application may not run
properly. Installing an application may also disrupt the Infiniium DCA
application, which may require you to recover the Infinilum DCA application.
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CAUTION

CAUTION

Using the 86100C
Windows XP Professional

Before installing any software, you should exit the Infiniium DCA application.
Click Exit on the File menu.

Windows XP registry: If the Infiniium DCA is mounted in a rack or cabinet, do
not use the system power switch to disconnect power from the instrument.
Instead, use the Infinilum DCA front-panel power switch. Using the system
power switch may corrupt the Windows XP registry requiring you to perform
the recovery procedure to restore normal operation to the Infiniium DCA.
Refer to “To recover the 86100C Drive-C” on page 2-24.

To minimize the 86100C DCA application
Click the minimize button that is located at the top right-hand corner of the
display.
Minimize
button

%5 Fle Cortrol sefup  Measure  Calibrate  Utilities  Help 15.Jan 2004 09:53 _|

Click Minimize on the File menu.
Press ALT-spacebar on the keyboard.

To exit the 86100C DCA application
Click Exit on the File menu.

To view the Windows Start Menu
Press the keyboard’s Windows logo key.
Press CTRL-ESC on the keyboard.

To return to the 86100C Application
= Click the taskbar 86100C Application g

Y esto0c

button, if the application is minimized. |

= Double click the program icon, if you need to start the application.

o
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Avoid changing these Windows system settings

NOTE

Avoid changing these Windows system settings

There are several Windows system settings that can be changed to suit your
own personal preferences. However, there are some system settings that you
should avoid changing, because it will interfere with the proper operation of
the Infiniium DCA.

Do not change the Power Options.

Do not change the System Properties Hardware Tab settings.

Do not change the System Properties Advanced Tab settings.

Do not change the Regional and Language Options Advanced Tab settings.

Do not remove Fonts.

Display Settings

< Do not turn off the screen saver. The screen saver turns off the display’s
backlights extending their life.

< Do not change the screen resolution from 640 by 480 pixels or the color qual-
ity from High (24 bit).

« Do not use the Windows XP Theme.

« Do not change “Windows and buttons” from the “Windows Classic Style”.

< Do not change the Font size to Extra Large.

« Do not change the menu fonts or size.

« Do not modify “1. Digital Flat Panel (640x480) on Chips and Technologies
(Asiliant) 65550,

« Do not set “Intel (r) 82815 Graphics Controller” to “Use this device as the
primary monitor”.

Do not delete or modify the InfiniiumAdmin user account.

Before changing any Windows System settings outside of the Infiniium DCA
application you should Exit the Infiniium DCA application.
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WARNING

Upgrading the
Instrument Software

Infiniium DCA Hard
Disk Drive Recovery

Confirm the Initial
Instrument Settings

Using the 86100C
If the Infiniium DCA has a Problem

If the Infiniilum DCA has a Problem

Use the information in this section to help you resolve technical problems with
your Infiniium DCA. Refer to “Avoid changing these Windows system settings”
on page 2-20 to confirm that system settings have not been changed improp-
erly.

No operator serviceable parts inside. Refer servicing to qualified
service personnel. To prevent electrical shock do not remove covers.

You can install the latest version of the software for the Infiniium DCA main-
frame. Newer software versions upgrade the operating system of the instru-
ment mainframe and the plug-in modules. The instrument's software can also
be downgraded to a previous version, if needed. Consult the online help for
these procedures.

The hard drive recovery procedure restores the instrument's hard disk in the
event that files and data have been corrupted. This can happen, for example,

as a result of inadvertent user changes or a computer virus. The procedure for
the 86100C is different from the procedure for the 86100A/B.

On 86100C instruments, the hard disk drive has two partitions: drive C and
drive D. Drive C contains the operating system, the 86100C application, and
any factory installed or user installed applications. Drive C also contains fac-
tory calibration data and application licenses, which are automatically backed
up to drive D. Drive D contains backup files and user files including data files.
If you install an application, such as virus protection, it is recommended, but
not required, that you install it on drive C.

Although there are several Windows System settings that can be changed,
avoid changing the following settings because any changes will interfere with
the proper operation of the Infiniilum DCA. Confirm that these setting have not
been changed.
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To upgrade 86100C instrument software

After you have obtained the software upgrade file for your 86100C, perform
the following steps.

Copy the software upgrade file to a USB Flash Drive, external USB CD-RW
drive, LAN folder, or other device so that the file will be available to copy to the
86100C.

On the 86100C, click Exit on the File menu and then click Yes to exit the
86100C application.

3 On the Start menu, click My Computer.

Select the D: drive and create a new folder. Give the new folder a meaningful
name. For example, Software Upgrade.

Copy the upgrade file (.msi file extension) from an external memory device to
your new folder.

Select the upgrade file to begin the installation. Click Next twice for the
installation wizard to automatically uninstall the current version and install the
newer version.

From the Windows desktop, double click the program icon to start the 86100C

software.
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To downgrade 86100C instrument software

To downgrade 86100C instrument software

After you have obtained the software version file for your 86100C, perform the
following steps:

Copy the software downgrade file to a USB Flash Drive, external USB CD-RW
drive, LAN folder, or other device so that the file will be available to copy to the
86100C.

On the 86100C, click Exit on the File menu and then click Yes to exit the
86100C application.

3 Click Control Panel on the Start menu.

10

Click Add or Remove Programs, and select the current 86100C Infiniium DCA
software version.

Click Remove, and then click Yes to remove the current software version.
Click My Computer on the Start menu.

Select the D: drive and create a new folder. Give the new folder a meaningful
name. For example, Software Upgrade.

Copy the new file (.msi file extension) from an external memory device to your
new folder.

Select the new file to begin the installation. Click Next twice for the installation
wizard to automatically install the new version.

From the Windows desktop, double click the program icon to start the 86100C

software.
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To recover the 86100C Drive-C

NOTE

To recover the 86100C Drive-C

This hard disk drive recovery re-images the drive-C partition, only. Because
the factory backup image resides on the hard disk, no external media is
required to recover drive C. After the recovery process is complete, the Infini-
ium DCA firmware is set to the version installed when the factory image was
created. To update to a later version after the recovery is completed, refer to
“To upgrade 86100C instrument software” on page 2-22.

When performing this recovery procedure, all application license files and
user files (including data files) are left unchanged. However, in case of a prob-
lem, you may want to make a backup of your data before you begin. After the
procedure completes, the Windows XP Setup Wizard will automatically run.

Once started, the time required to complete the recovery is approximately 10
minutes.

1 Connect a keyboard to the instrument.

2 Turnon the instrument. After approximately 30 seconds, look for the following

displayed text.

Please select the operating system to start:

86100C Infiniium DCA
Emergency Backup And Recovery

3 Immediately, press the down arrow key on the keyboard to select Emergency

Backup And Recovery. Then, press the Enter key.

4 After more text is displayed, press the Enter key to display the screen shown
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To recover the 86100C Drive-C

in the following figure.

86100C Infiniium DCA
Recovery & Backup Options

Choose One of the following:

1. Recover Factory Backup Image

2. Exit

Enter a Choice:

5 To enter the recovery procedure, press the 1 key.

6 On the next screen press C to recover the hard disk. Press E to exit the
procedure.

7 Another screen is displayed giving you one more chance to enter or exit the
procedure. Press C to recover the hard disk. Press E to exit the procedure.

NOTE

This is your last chance to abort the recovery process. Once the hard drive
recovery procedure starts, do not interupt the procedure with any key presses.
The procedure requires about 10 minutes to complete.

8 When the "Recovery Process is complete!" message is displayed, press
CLT+ALT+DEL on the keyboard.

9 The Windows XP Setup Wizard automatically starts. Follow the steps listed on
the screen. The Certificate of Authenticity is located on the instrument's rear
panel.
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To restore the 86100C Drive-D

Drive D on the 86100C hard disk contains all user files including data files. It
also includes backup copies of the factory calibration and application license
files that are automatically created from Drive C by the instrument. To restore
drive D back to factory defaults, you must reformat the partition using the
Windows XP Format utility. Formatting will erase all data on drive D.

CAUTION Performing a Drive C Recovery immediately after formatting the D partition
(without restarting the instrument) results in the loss of factory calibration and
any application license files. Always turn off and then restart the instrument
after performing the Drive-D Restoration procedure.

1 Click Exit on the File menu to close the 86100C application.

Internet | My Recent Documents »
Internet Explorer

;’_-J E-mail

=
¥ My Computer

Control Panel

'@ Tour Windows XP ™
&é Printers and Faxes

@ ‘Windows Movie Maker .
9) Help and Support
<@ | Files and Settings Transfer e
Wiizard ,-) Search

I run..

all Programs » g 86100C Infiniium DCA

. | Turn OFF Computer

Figure 2-10. Windows Start Menu

3 Click My Computer and select the USER (D:) drive.

4 On the File menu, click Format, Start, and then OK. Do not change the default
setup. Leave the Format Options selections unchecked.

5 When the Format Complete dialog box appears, click OK.
6 Click Close.
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7 Turn off and then restart the 86100C. The 86100C automatically performs the
following tasks:

e Creates the original factory folders on drive D

« Creates backup copies of the factory calibration and any application license
files that reside on drive C.
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Using the Built-In Information System

Using the Built-In Information System

Where is the operating manual for your infiniium DCA? It is built into your
instrument! To access the built-in information system, referred to as Help,
simply click Contents on the Help menu.

“5 Fle Control Setup  Measure  Calbrate  Utilities  Help 15 Jan 2004 09:42 _|

Eye/Mask Made..
e/ Mask Mode Cantents...
About BR100C...

R
Msk Test'zi i =

Figure 3-1. Contents on the Help menu

This will open the Contents topic that is shown in Figure 3-2. Exploring the
Help should be familiar to you because it is similar to other Windows applica-
tions. You can, of course, use the touch screen or the mouse to explore the
Help. In addition to the 11 topics presented in the contents, be sure to use the
index buttons located along the bottom of the topic window. These can be
very helpful in locating a topic of interest.

When using the Help, you can temporarily hide it so that you can
see the entire display. Then, you can re-display the Help with the

same topic still showing. To hide the Help, touch the Minimize
button located at the top of the Help window. To re-display the :
Help, touch the Restore button that is shown on the display.
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_ _ General Networking,
Four |_nstrument |nstrum_ent Step-by-step printing, and file
operating modes operation procedures management

New ¢ hang es B Infiniium DCA Help Contents  (Revision A.04.10) x|
for 86100C T e T e T o e
New F eatures i \ /
B Bl
General bl -] .@ l g
information
Getting Started  Instrumennt Using the Setup Guide  Files, Printing,
Modes Instrument and Networks
Connector Technical
Care Support
E Contacting
Optical and Agilent
electrical M {Pleaseiclick a Iet‘ler}
connectors / \
Plug-in Mainframe Definitions for Index
module and module displayed
descriptions specification messages

Figure 3-2. Help Contents
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Getting Help While Changing Instrument Settings

Help is available directly from displayed dialog boxes.

To see overview information in an open dialog box, touch the Book icon. A top-
ic window opens and describes the dialog box and its controls.

To get information on a specific item in the dialog box, touch the What’s this?
icon. Then touch the desired control on the dialog box. A window appears with
a description of the selected control, as shown in the following figure.

Book icon What's this? icon

Set Time and Date m

F Shove Time and Date on Screen

Click/ftouch this box to turn the time and date display

Hour on or off. ¥hen this box is checked, the current time
14 and date is displayed at the upper right hand comer of
the display screen. By default, the time and date are

displayed.

“ear

2000 v| Al

Set Time &
Diate Mow
Sl

Figure 3-3. Help in dialog boxes
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Learning About Measurement Results

After a measurement is performed, the displays shows the Measure tab which
includes the measurement results. The fastest way to get help on measure-
ment configuration or algorithms is to touch the Setup & Info button. The
following figure shows the location of this button.

¥ Annotate Measurements
Configure Meas...

Annatate Ex

m Jitter RMS(2)
.~ Measure ¢ Remove Awg Power(2)

current i

* » B

Bt LGy SR T ey "~ Crossing %(2) Setup
Jditter RMS( } MNRZ Eye? ? 2.8806 ns ? 2.59 & i
fvg Power{ ) 32031 mW 30078 W 328.13 oM B5.535 k
D
Measure Setup & info
tab button

Figure 3-4. Help on measurement results
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Printing Topics

= To print the contents of a Help topic, click the Print button, located at the top
of the Help window.

« To print the contents of a pop-up window, place the pointer over the pop-up,
click the right mouse button, and then click Print Topic.

g | I General Spel agrenyation

Attenuation

The process of reducing the amplitude of a waveform without

introducing significant distortion. For examale. the inout wavefo
a standard 10:1 probe will be reduced Copy
20 dB.
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Figure 3-5. Printing a pop-up window
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Working in Comfort

Working in Comfort

To optimize your comfort and productivity, it is important that you set up your
work area correctly and use your Agilent product properly. With that in mind,
we have developed some setup and use recommendations for you to follow
based on established ergonomic principles.

Improper and prolonged use of keyboards and input devices are among those
tasks that have been associated with repetitive strain injury (RSI) to soft tis-
sues in the hands and arms. If you experience discomfort or pain while using
your Agilent Technologies product, discontinue use immediately and consult
your physician as soon as possible.

Please study the recommendations offered here in this chapter. You may also
wish to consult your employer’s human resources department or other rele-
vant departments for guidance specific to your company.
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What is RSI?

What causes RSI?

What if | experience
discomfort?

About Repetitive Strain Injury

Because your comfort and safety are our primary concern, we strongly recom-
mend that you use the infiniium DCA in accordance with established ergo-
nomic principles and recommendations. Scientific literature suggests that
there may be a relationship between injury to soft tissues - especially in the
hands and arms - and prolonged improper use of keyboards or other equip-
ment requiring repeated motions of the hands and forearms. This literature
also suggests that there are many other risk factor that may increase the
chance of such injury, commonly called Repetitive Strain Injury.

Repetitive Strain Injury (RSI—also known as cumulative trauma disorder or
repetitive motion injury) is a type of injury where soft tissues in the body, such
as muscles, nerves, or tendons, become irritated or inflamed. RSI has been a
reported problem for those who perform repetitive tasks such as assembly line
work, meatpacking, sewing, playing musical instruments, and computer work.
RSI has also been observed in those who frequently engage in activities such
as carpentry, knitting, housework, gardening, tennis, windsurfing and lifting
children.

The specific causes of RSI have not been established. Nevertheless, the inci-
dence of RSI has been associated with a variety of risk factors, including:
Too many uninterrupted repetitions of an activity or motion.

Performing an activity in an awkward or unnatural posture.

Maintaining a static position for prolonged periods.

Failing to take frequent short breaks.

Other environmental and social factors.

In addition, there have been reports associating the occurrence of RSI with
the use of keyboards, mice, and other input devices. Also, certain medical con-
ditions, such as rheumatoid arthritis, obesity and diabetes, may predispose
people to this type of injury.

If you are experiencing any discomfort, seek professional medical advice
immediately. Typically, the earlier a problem is diagnosed and treated, the eas-
ier it is to resolve.

4-3



Working in Comfort
Mice and Other Input Devices

Mice and Other Input Devices

Various aspects of using mice and other input devices may increase your risk
of discomfort or injury. Observing the following recommendations may reduce
that risk.

Try to keep your hand, wrist, and forearm in a neutral position while using your
mouse or other input device.

If you use your thumb to rotate the ball on a trackball or spaceball, keep it in a
relaxed, natural shape, and maintain a neutral posture in your hand, wrist, and
forearm.

Hold the mouse gently by draping your fingers over it. Keep your hand relaxed
and fingers loose. Do not grip the mouse tightly.

It takes very little pressure or force from your fingers to activate the buttons or
scroll wheel on your mouse, scrolling mouse, trackball, or other input device.
Using too much force can place unnecessary stress on the tendons and muscles
in your hands, wrists, and forearms.

If you are using a scrolling mouse, be sure to keep your fingers and hand in a
relaxed, neutral position when activating the scroll wheel. Also, this type of
mouse features software that can minimize the number of mouse movements
or button clicks.

When using a mouse, trackball, or other input device, position it as close to the
keyboard as possible, and keep it at the same level as you do not have to stretch
while using it.

Use a good quality mouse pad to enable the mouse to work most effectively and
reduce unnecessary hand and wrist movements.

Be sure to keep your mouse and trackball clean. Regular removal of accumulat-
ed dust and dirt helps ensure proper tracking and reduces unnecessary hand
and wrist motions.
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